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Objective
This tutorial is intended to provide some experience and familiarity with MSC.ADAMS for modeling simple systems. It refers to Version 2005 R2 of ADAMS.
Problem Description

We will be modeling a single DOF spring-mass-damper system. In this case, M = 137 kg, k = 8.5 N/mm and c = 0.650 Ns/mm.
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Figure 1: the Model

The size and rotational inertia of the block are arbitrary since we are going to treat it as a point mass. We must, however, ensure that ADAMS knows this.

Procedure:

Our general procedure will be to: start and set-up ADAMS and get familiar with the interface; create the masses for our model; create necessary joints, including joints with specified motion to apply to our system; create springs and dampers; verify the model (appropriate degrees of freedom); establish static equilibrium; perform a linear stability analysis; and finally perform a dynamic simulation).

Starting ADAMS
1. From the ADAMS product menu, select ADAMS/View. 

2. From the initial menu, select Create a new model, and verify gravity and units. 

3. The Gravity text field should be set to Earth Normal (-Global Y), and the Units text field should be set to MMKS - mm,kg,N,s,deg. 

4. Select OK to start the program.

Note: you can specify a different model name and default directory (Start in…) in this pane as well. Leave the model name as is (model_1) for the purposes of this tutorial.

The Main Toolbox

All of the important functions for model building in ADAMS can be accessed from the main toolbox. You should always have the main toolbox visible, but if you close it by mistake you can get it back by using the View pull down menu and clicking on “Toolboxes and Toolbars”. 
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Figure 2: Main Toolbox

Viewing Models in ADAMS 

Before we get started, you should get familiar with navigating around a model in ADAMS. 

1. Holding the z key, left clicking, and moving the mouse up and down, allows you to zoom in and out.  

2. Holding the r key, left clicking, and moving the mouse, allows you to rotate your model on the screen.

3. Holding the t key, left clicking, and moving the mouse, will translate the model from place to place on the screen.

There are also a number of Pre-Set views that can be accessed from the View pull-down menu. By default, ADAMS starts with a Front view. 

If you have rotated to a different view, return to the front view before continuing with this tutorial.

Set up a Useful Working Grid

5. Go to the Settings pull-down menu window and select Working Grid.
2. In the Size text field, enter 1000mm under both X and Y.

3. In the Spacing text field, enter 100mm for both X and Y. 

4. Click OK and notice that the working grid has changed. 

Now go to the View pull-down menu at the top of the ADAMS window and select Coordinate Window. This will display the co-ordinates of the nearest grid point on the screen, and will be useful when we create our model.

Create the Block:

Right click on the Rigid Body Icon, [image: image3.png]I Lengtl
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, then left click on the Box icon [image: image4.png]Construction
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. (Note: Rigid Body refers to the set of icons available in this position; the Link icon is the (original) default, and we need to right click to see the other options. Once we change the default, we can left click directly to initiate). The rest of the main toolbox now contains commands to help you create your box. We would like to visualize our mass as a cube with sides of length 20cm, so enter 20cm in the length, height, and depth fields. Make sure to check the length height and depth boxes to indicate to ADAMS that these values should be used. 

[image: image5.png][ X ain Tookholgh |
A

A

n
2|3
a
g

NewPat  ~|
7 Length
@0.0cm)
7 Height
(20.0cm)
7 Depth
@0.0cm)

Render | lcons





Figure 3: Setting Box Dimensions

Now point to and select (left click) grid point (-100, 400, 0) to position the lower left corner of the box. Your part has been created. 

Note:  The program prompts you for what it is expecting next in the status bar at the bottom of the screen. If you make a mistake, you can undo from the Edit menu or by pressing ctrl-Z. Press ESC to ‘get out of’ a command.

Rename the Block:

1. Right click on the part and point to Part: Part_2, and then select Rename. 

2. Leave the model name (model_1) as it is, replacing the name of Part_2 with Block. The complete part name should be .model_1.Block
Move the Block:

From the View pull-down menu, select Pre-Set and then Iso. The isometric view shows that the block is not centered in the xy plane. In order to avoid difficulties later, we will move the block so that its center of mass is in the xy plane. View the body from the left (View/Pre-Set/Left) before executing the following commands, then go back to the front view.

1. From the main toolbox, right click on the Position icon, [image: image6.png]x|
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, then left click on the Move icon, [image: image7.png]| €
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2. Select the Block as the part you would like to move (by clicking on it).

3. Select the center of mass of the block (ie the marker labeled Block.cm) as the point to move.

4. Select the grid point at (0,500,0) as the point to move to.

5. Remember to go back to the front view.

Set Mass Properties of the Block:
1. Right click on the Block, and choose Modify.  A dialogue box appears.

2. Verify that the category is Mass Properties.
3. Select Define the Mass By User Input.  

4. Enter the correct mass of the block (137 kg – you can just enter 137 since the units are mm-kg-s).  You can leave default rotational inertia values. They won’t matter since the block will be constrained such that it can’t rotate. Note that setting the inertias to zero will cause simulation errors due to a zero pivot in the mass matrix (try it if you are interested).

5. Press OK to accept.

Create a Translational Joint:

We will use a translational joint to constrain the Block to move in a straight line.
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 then left click on the Translational icon, [image: image9.png]—_—
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2. Verify that the construction method is 2 Bodies, 1 Location.

3. Select the Ground (left click anywhere on the screen other than over the Block) and the Block as the two bodies to join

4. Select the cm marker (center of mass – Block.cm) of the Block for the joint location.

5. Specify a vector in the vertical direction as the joint axis (ie. pick any point along the y axis)

Your model should look like the following at this point:
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Create a Part to Represent the Input Motion of the Ground

1. Create another part using the Rigid Body: Box tool [image: image11.png]Construction
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. Make the dimensions of this new block whatever you please. Note: if you wish to change the dimensions after it is created, right click over the block and select the ‘box’ to modify, not the actual part. 
2. Rename the part Input (its full name will be .model_1.Input)
3. Move its center of mass to the grid point located at (0,0,0).

4. Create a Translational Joint between the Input and the Ground, in the same orientation and using the same procedure used to create a Translational joint between the Block and Ground.

Note: it is not necessary to modify the mass properties of the Input part since they are not important to this problem.

Define a Step Input

1. Right click on the Translational Joint (likely called Joint_2 at this point) that connects the Input part to the Ground and select Modify. A dialogue box appears. Click on the Impose Motion(s) button.

2. The only direction in which motion can be imposes is Tra Z. Change the motion from free to disp(time) = from the pull-down menu and type the following expression in the window to the right of ‘disp(time)=’:

STEP(time , 0 , 0 , 0.05 , 50 )

Note that these arguments correspond to:  time, initial time, initial function value (displacement in this case), final time, and final function value.

This creates a function that starts at zero at time = 0, and ramps to 50 mm at time = 0.05 seconds. It remains at this final value after the final time.

Note: Since the displacement of the road is zero at time = 0, this imposed motion will not affect the calculation of equilibrium positions in ADAMS.
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Figure 4: The Impose Motion Dialogue Box

Create a Spring and Damper:

1. Left click on the Connector: Translational Spring-Damper icon, [image: image13.png]x
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2. Select the Input.cm and Block.cm as the two points to join

Modify Properties of Spring and Damper:

1. Right click on the Spring/Damper and select Modify. 

2. Enter the correct spring coefficient (8.5 N/mm) and damping coefficient (0.65 Ns/mm)

3. Enter a preload of 1343 N. 

Note: the spring preload is the force through the spring when the spring is in its nominal position (the position it was drawn). If there was no preload, the block would free fall until the spring builds up enough force to stop it or reverse its direction. Therefore, the model may reach equilibrium in a state that is nothing close to the position in which its was drawn.

ADAMS solves for equilibrium position using an iterative procedure in which the nominal position is used as an initial guess. In order to ensure that ADAMS will find an equilibrium position of our model, it is recommended that the preload be set to the weight of the mass being supported - in this case, Mg = 1343 N.  

Verify the Model

1. Open the Simulation Control Toolbox by using the Simulate pull-down menu and clicking on Interactive Controls.

2. Click on the Verify Model icon, [image: image14.png]=]
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Figure 5: Simulation Control Toolbox

Note: The model verification step is one way to find errors in the model definition. ADAMS checks for misaligned joints, unconstrained parts, or mass-less parts in dynamic systems, and alerts you to other possible problems in the model. After seeing that the model has verified successfully, click on the Close button in the upper right corner to close the Information Window.

Find Equilibrium Position

Click on the Find Static Equilibrium icon [image: image16.png]=]
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 in the Simulation Control Toolbox.

Note: If you have specified a reasonable value for spring preload, then the equilibrium position will be very close to the position in which the model was drawn. If you have neglected to specify a spring preload, the equilibrium position will be very different, or may not be found at all.

Linear Systems Analysis

ADAMS has the power to linearize complex models about an operating point (defined by the position the model is displayed on the screen) and then perform an eigenvalue analysis. This can be extremely useful for investigating the stability a system, or validating calculations done using some other software.

1. Click on the Compute Linear Modes icon, [image: image17.png]=]
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2. Click ‘Animate’ when ADAMS prompts you to view results of the Linear Mode analysis. The Linear Modes Control Toolbox Appears
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Figure 6: Linear Modes Control Toolbox

The natural frequencies (in Hz) and damping ratios associated with each linear mode are displayed in the Linear Modes Control Toolbox. Because this model has only one degree of freedom, it only has one Linear Mode. To view an animation of the shape of this mode, click on the Animate icon in the Linear Modes Control Toolbox, [image: image19.png]Eigen: | EIGDDDD0D4
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.

There are two options available to those who would like to view the system’s eigenvalues. You can either view them in tabular form or as a plot in the complex plane by pushing the appropriate button at the bottom of the Linear Modes Control toolbox.

When you are done investigating Linear Modes, click on the [image: image20.png]Eigen: | EIGDDDD0D4

View: [ main.

Mode Number

Fregquency

Darmping Ratio [%]: 301171
Frames Per Cycle: |20 =

Nurnber Of Cycles: |3

I~ Show time

I~ Show undeformed [~ Show icons

Undef, Color:

Max. Translation

Max. Rotation:

Eigenvalue:

front

of 1

1.1954

decay I~ Show trail

red

Table...| Plat.



 icon to return to the Simulation Control Toolbox.
Run a Time Domain Simulation

You should have the Simulation Control Toolbox open. 

1. Set the End Time to 2 seconds.

2. Set the number of output steps to 100.

3. Check the Start at Equilibrium box. (for this analysis, is important that the model be in its equilibrium position at time = 0 ).
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Note:  You can run the simulation by pressing the play icon [image: image22.png]=] >
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. To replay the animation, press the ‘replay’ icon [image: image23.png]1 ADAMS/View 12.0.0
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You may get errors if you try to run [image: image24.png]=] >
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 the simulation again without actually stopping [image: image25.png]1 ADAMS/View 12.0.0
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 the simulation

View Results:

1. Click on the Plotting icon, [image: image27.png]x|
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, in the Main Toolbox. This will bring up the post-processor window

2. Select Results Set from the Source window.

3. From the Result Set list at the bottom of the screen, select BLOCK_XFORM. 

4. From the Component list, select Y.
5. Click the Add Curves button.

The graph that appears represents the vertical displacement of the Block from its equilibrium condition (as a function of time).

Export Results

It is sometimes useful to export results from ADAMS so that they can be compared or combined with results from other software.

1. From the Post-Processor window, use the File pull down menu and select Export followed by Table. A dialogue box appears.

2. In the File Name field, enter the complete path of the results file you wish to create (it shouldn’t already exist). For example, you might type C:\Documents and Settings\Kevin\results.xls. Note: you can also right click and pick ‘Browse…’. 

3. Right click on the Plot Field, and select Pick (you are going to pick the plot you want to export data for). Left click anywhere on the current plot. Note: you can also ‘Browse…’ for this as well if you have only one plot and/or know its name.
4. Verify that Spreadsheet is selected in the format field (assuming you want to view your results using spreadsheet software like Microsoft Excel).
5. Click OK. Your results file has been created.
You can exit the post-processor window by closing it, and you should be returned to the ADAMS model.





















